Description

Embedded
Retaining Wall

For LUSAS version: 23.0
For software product(s): | LUSAS Civil & Structural or LUSAS Bridge.
With product option(s): | Nonlinear.

Description

An embedded retaining wall is
required to retain 6.5m of loose sand
along with an additional surcharge of

Surcharge, g=10kN/m?

10kN/m?. A 2D analysis is to be

carried out with the soil represented I Loose sand
by tri-linear earth pressure joint g )};1_20“2\‘(4 m?
material for both an unpropped and a Ko;0'65
propped wall condition. J Kp=2:75

The units of the analysis are kN, m,
t, s, C throughout.

Concrete wall
Objectives 0.5m thickness

U To calculate bending 20m Dense sandy clay

moment and shear forces in y=17kN/m?3
the embedded wall and Ka=0.33
ensure that deflections are Ko=0.50
within serviceable limits. Kp=3.0

U To investigate the effects of
installing a prop and
reducing the pile length.
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Embedded Retaining Wall

Associated Files

Associated files can be downloaded from the user area of the LUSAS website.

] U embedded_wall_modelling.lvb carries out the modelling of this example.
‘I ‘

Modelling

Note. Model and results images included in this example were captured in an earlier
/ version and may differ in appearance from those seen and obtained from this version.

Running LUSAS Modeller

For details of how to run LUSAS Modeller, see the heading Running LUSAS Modeller in
the Examples Manual Introduction.

started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Note. This example is written assuming a new LUSAS Modeller session has been

Creating a new model
e Enter a File name of Embedded Wall

e Use the default User-defined working folder.

e Ensure an Analysis type of Structural is set.

e Select an Analysis Category of 2D Inplane

e Set Model units of kN,m,t,s,C

e Leave the Timescale units as Seconds

e Select a Startup template of None.

e Ensure the Layout grid is set as None

o Enter a Title of Embedded Retaining Wall Example
e Click the OK button.

Note. Save the model regularly as the example progresses. Use the Undo button to
/ correct any mistakes made since the last save was done.




| Geometry
Point >
By Coords...

| Geometry
Line >
By Sweeping. ..

| Geometry
Line >
By Sweeping. ..

| Geometry
Line >
By Sweeping. ..

Modelling

Defining the Wall Geometry

e Enter coordinate (0, 0, 0) to define ground level and the top point of the wall. Click
the OK button to create a single point at the origin.

Note. Scparate lines must be defined to represent each change of
soil type.

o Select the newly created Point. -

ﬂl Sweep the selected point with a Y translation of -2.5 and click
the OK button to create the new Line.

e Select the newly created lower point

él Sweep the selected point with a Y translation of -4.0 and click
the OK button to define the new Line.

e Select the newly created bottom point

él Sweep the selected point with a Y translation of -20.0 then
click the OK button to define the new Line.




| Geometry
Line >
Copy...
| Geometry
Line >
Copy...
| Geometry
Line >
Delete...
| File
Save

Embedded Retaining Wall

Defining the Earth Geometry

The earth pressure acting on the wall is modelled using joint
elements connected between the wall itself and fixed supports.
Additional lines are required to assign the fixed sides of the joint !
elements to.

Note. Joint elements should normally have a zero length, » 1
however, to reduce confusion from overlapping features during
definition they are usually initially located with a gap that is
later closed once the model has been setup.

e Select all lines and points (Press Ctrl + A keys)

m Copy all the geometry by 3.0 in the X direction and click
OK to define the retained soil.

e With the wall structure still selected:

m Copy all the geometry by -3.0 in the X direction and click
OK to define the retained soil. . .

ﬁ Select the upper two lines of the excavated side and delete them.

The geometry is now complete. The central series of lines represent the wall. The lines
to either side represent the soil. A load which represents the propping force applied to
the upper part of the wall will be added to the model later in the example.

El Save the model file.

Meshing

Note. Due to the underlying implementation of the tri-linear earth pressure material
model, the joint elements that the soil material will be assigned to must be orientated in
a specific way:

e For both 2D and 3D joint elements the joint element local x axis must align with the
horizontal and connect the support to the structure.

e For 2D joint elements the local y axis must be aligned to the model vertical axis
e For 3D joint elements the local z must be aligned to the model vertical axis.

Note that the model vertical axis can be seen and changed on the model properties
dialog, which can also be accessed by the Tools > Vertical Axis menu item.




| Attributes

Modelling

| Local Coordinates...

| Attributes

|Mesh
| Line...

| Attributes

|Mesh
| Line...

Defining local coordinate systems

To ensure the joint elements are orientated correctly two local coordinate systems are
needed: one in the direction of the main model X axis, and one in an opposing
direction.

e Create a local Cartesian coordinate system rotated 0 N
degrees about the Z-axis with an Origin of (-3,0,0), enter t . “1
the dataset name as Excavated and click Apply k < .

e Create a second local Cartesian coordinate system rotated
180 degrees about the Z-axis with an Origin of (3,0,0),
enter the dataset name as Retained and click OK.

. El Press the Isometric button to see the local coordinate
systems created.

Defining element types

The joint elements are required to have displacements in the u
and v directions to represent horizontal and vertical pressures.
For this 2D problem, using a 2D joint element for bars, plane
stress and plane strain, which connects two nodes by two
springs in the local x and y-directions is sufficient.

e Select the element type as Joint no rotational stiffness. Enter the dataset name as
Soil Mesh and click the OK button.

The wall requires thick beam elements:

e Select the element type as Thick beam and the interpolation order as Linear.
Select an Element length of 1.0. Enter the dataset name as Thick Beam and click
the OK button.

Assigning the elements

The wall is meshed first, and the joint elements are then assigned between the lines
representing the soil and the wall.

Wall

e Seclect the three central lines representing the wall and drag the dataset Thick Beam
the & Treeview onto the model.




| Edit

Selection Memory >
Set

Embedded Retaining Wall

<

Excavated side

e Select the left-hand line representing the excavated earth and then
(by holding down the Shift key) also select the corresponding
adjacent line of the wall.

e Drag the dataset Soil Mesh from the A Treeview onto the model.
In the Line Mesh Assignment dialog, select Excavated from the
specified local coordinates list and ensure Mesh from primary to
secondary is selected. Click OK to complete the assignment.

Note. The first line that is selected will be the ‘Primary’ and the
second line selected becomes the ‘Secondary’.

T, A

Retained side

e C(lick in a blank part of the view window to deselect the two lines previously
selected, then select (from top to bottom) the three central lines representing the
wall.

Note. To make joint mesh assignments to sets of multiple lines the selection memory
must be used:

This places the lines in the selection memory. Ca

e Click in a blank part of the view window to deselect the three lines I<’
previously selected. Note that they will remain ‘highlighted’ because
they are in selection memory.

e Select (from top to bottom) the three lines on the far right
representing the retained soil.

e Drag the dataset Soil Mesh from the & Treeview onto the model. In
the Line Mesh Assignment dialog, select Retained from the
specified local coordinates list and ensure Mesh from primary to
secondary is selected. Click OK to complete the assignment.

Note. In this instance the lines selected in the View window are the
‘Primary’ ones and the lines present in the selection memory are the
‘Secondary’ ones. Selecting the lines from top to bottom ensure each
‘primary’ is mapped to the correct ‘secondary’.




| Edit

Selection Memory >
Clear

| Attributes

| Geometric >
Section
Calculators. ..

| Attributes

Material >
Material Library...

Modelling

This clears the selection memory.

The previous image shows the model after selection memory has been cleared with the
joints correctly assigned.

Note. If necessary, the joint element axes can be visualised and checked by editing the
Mesh layer properties (double-click the Mesh layer name in the Treeview) and
selecting Show element axes.

Note. If necessary, line mesh assignments can be checked by selecting a line, viewing
its Properties, and selecting the Details option for the corresponding mesh entry.

Geometric Properties for Wall

On the Geometric Line dialog select Parametric sections, then
Rectangular sections, then New.

On the Rectangular Solid Section Property dialog enter D=0.5
and B=1.0

Change the name to be Wall and click OK to finish defining
section properties. An entry of Wall (RSS D=0.5 B=1) will be

added to the Utilities m"’ﬁ treeview.

Back on the Geometric Line dialog enter the name of Wall 1m
run and click OK to create the geometric attribute readuy for
assignment to the model.

Select the three lines representing the wall and drag the

geometric attribute Wall 1m run from the & Treeview onto
the chosen features.

Geometric properties are visualised by default.

!l Select the fleshing on/off button to turn-off the geometric
visualisation.

Material Properties

W

T~

ke

From the drop-down lists select material type Concrete, region Europe, Standard
grade EN1992-1-1:2004/2014 and Grade C40/50 and click OK to add the material

dataset to the & Treeview.

Select the three lines representing the wall and drag and drop the geometry attribute
Isol (C40/50 | Concrete | EN1992-1-1:2004/2014) from the A Treeview onto the

selected lines.




| Attributes

Embedded Retaining Wall

[ Material
[ Joint...

e In the Joint Material dialog select Trilinear Earth Pressure and select Next. Three
earth pressure material attributes are required: one for the Loose Sand, and two for
the Dense Sandy Clay (where one is for the retained side, and one is for the

excavated side).

e All materials are to be defined for use with Two dimensional joint elements
(which is set by default) with the defining geometry being Lines.

To create the Loose Sand material, enter the following properties:

Datum used for the calculation of effective overburden pressure | Zo 0.0
Surcharge (vertical load per unit area) q 10.0
Unit weight of soil v 12.0
Angle of shearing resistance between soil and structure () 0.0
Cocfficient of passive earth pressure Kp 2.75
Coecfficient of passive earth pressure due to cohesion Kpe [ 0.0
Cohesion c' 0.0
Cocfficient of at-rest earth pressure Ko 0.65
Coecfficient of active earth pressure Ka 0.20
Coecfficient of active earth pressure due to cohesion Kac 0.0
Empirical constant used in calculation of kh A 1E3
Empirical constant used in calculation of kh B 250.0
Empirical constant used in calculation of kh K 1.0
Soil width Weff | 1.0

e Observing the local coordinate system established for the retained side, select
Active pressures to define just what the positive displacement of the local x axis
mobilises (i.e towards the wall) and Matches gravity (points down) to define just

what the positive direction of the local y axis represents.

e Deselect Consider angle of structure

e Enter a dataset name of Loose Sand Retained and click Apply to create the

attribute.

The dialog should look like this:




Modelling

Trilinear Earth Pressure X
Joint type Two dimensional joint elements Local y axis aligned with global vertical axis
Defining geometry Lines b Structure Support
Vertical pressures «—‘L
Local x axis connects support to structure
Parameter Symbol  Value
Datum used for the calculation of effective overburden pressure Zo 0.0
Surcharge (vertical load per unt area) q 0 Vetical pressures  Lateral pressures
iicEriiaicr. 0 1z Lateral pressure, &
Angle of shearing resistance between soil and structure 8 0.0
Passive '
Latersl prassures cTT T
Parameter Symbol  Value L
Coeficiert of passive earth pressure Ko 275 h )
Coefficient of passive earth pressure due to cohesion K |00 r R T0  active
Cohesion ¢ 00 Tas
Coefficient of at+est earth pressure Ko 0.65 Horizontal defection
Coefficient of active earth pressure Ka 02
Coefficient of active earth pressure due to cohesion Kac 00 o'y =Ko0'y — 2¢'Ky,
Empirical constant used in calculation of kh A 1ed
Empirical constant used in calculation of kh B 2500 kh =A+BZ* CF’O = KD U,z
Empirical constant used in calculation of kh K 1.0 ’ ] ,
Soi wikh Wef Op =Kpoz+ 20Ky,
Positive displacement of the local x axis mobilises Posttive direction of the local y axis
®) Active pressures () Opposes gravity (points up) Censider angle of structure
O Passive pressures (®) Matches gravity (points down) [] Non recoverable
Name | Loose sand retained ~ | (new)
Next Einish Cancel Apply Help
Then, to define dense sand, change the parameters to the following:
Datum used for the calculation of effective overburden pressure | Zo -6.5
Surcharge (vertical load per unit area) q 88.0
Unit weight of soil Y 17.0
Angle of shearing resistance between soil and structure S 0.0
Cocfficient of passive earth pressure Kp 3.0
Coecfficient of passive earth pressure due to cohesion Kpc 0.0
Cohesion c' 0.0
Cocfficient of at-rest earth pressure Ko 0.5
Coecfficient of passive earth pressure due to cohesion Ka 0.33
Coecfficient of active earth pressure due to cohesion Kac 0.0
Empirical constant used in calculation of kh A 1E3
Empirical constant used in calculation of kh B 250.0
Empirical constant used in calculation of kh K 1.0
Soil width Weff | 1.0

Enter a dataset name of Dense Sand Retained and click Apply to create the

attribute.




Embedded Retaining Wall

Finally, to define dense sand excavated, change the Surcharge value to 0.0 and
observing the local coordinate system established for the excavated side, ensure Active
pressures is set to define just what the positive displacement of the local x axis
mobilises and select Opposes gravity (points up) to define just what the positive
direction of the local y axis represents. Leave any other settings unchanged. Change the
dataset name to Dense Sand Excavated and click Finish to create the final soil
material attribute.

Note. When creating soil layers, if a different soil weight is used for each layer the
overburden pressure from any soil layers above must be calculated manually and
entered as a surcharge. Where all layers have the same unit weight the datum for each
layer can be the same (that is, ground level) remembering that any additional surcharge
(q) at ground level needs to be included in the definition of all lower layers. In this
example the dense sandy clay on the retained side was given a surcharge of 88kN/m?.
This was calculated from the depth of sand above plus the applied surcharge such that q
=6.5x12+10=288

e Select the upper two lines representing the loose sand on the retained side of the
wall (not the wall itself) and drag the material attribute Loose Sand Retained from

the & Treeview onto the model.

e Select the bottom line representing the dense sand on the retained side of the wall

and drag the material attribute Dense Sand Retained from the o Treeview onto
the model.

e Select the line representing the dense sand on the excavated side of the wall and

drag the material attribute Dense Sand Excavated from the p. S Treeview onto the
model.

Note. Earth pressure joint material attributes are held in the &% Treeview. Context
menu entries named Edit Definition... and Edit Attribute... can also be seen by right
clicking on an attribute.

O Selecting the Edit Definition... menu entry or double clicking the attribute name
displays the original definition dialog with all the original input data for viewing or
editing.

U Selecting the Edit Attribute... menu entry displays the joint type and stored
piecewise linear joint material values that are used to define the earth pressure joint
material. Note that whilst these values may be changed, the link to the original
definition dialog will be broken.

10



| Attributes

Support...

| Attributes
Support...

| File

Save

Modelling

Supports

Fy
For the wall it is assumed that a supported end condition exists. T—»

e Select a Fixed translation for the Y axis, enter a dataset name of
Fixed in Y and click OK to create the attribute.

e Select the point representing the bottom of the wall then drag the

support attribute Fixed Y from the the . Treeview onto the
model for all analysis loadcases.

The Trilinear earth pressure material generates forces in the joint
elements appropriate to the position (depth) of the joint element in
the model. These forces must be resisted by supporting the free end
of the joint elements.

e Select Fixed translations for the X and Y axes, enter a dataset
name of Fixed and click OK to create the attribute.

o Select the lines representing the excavated and retained soils and

drag the support attribute Fixed from the & Treeview onto the
model. Accept the defaults in the assignment dialog.

Defining Nonlinear controls

The Trilinear earth pressure material is a nonlinear material and therefore a nonlinear
analysis is required.

e In the Analyses (5 Treeview, right click on Loadcase 1. From the Context menu
select Controls > Nonlinear and Transient

¢ In the Nonlinear & Transient dialog check the Nonlinear check box (leaving all
setting and values as their defaults) and select the OK button to return to the model.

Saving the model

El Save the model file.

Caution. For ease of definition the joint elements used have been inserted into the
model a set distance away from where they will be acting and, as a result, they have a
non-zero length. Note that, by default, Modeller ignores the joint length. In other
situations if it is required to solve the model considering the joint length, a geometric
attribute should be defined using the Attributes > Geometric > Joint menu item, and
selecting the ‘Use joint length’ option, before assigning the attribute to the three lines
representing the wall that were defined to be the ‘master; for the assigned line mesh
attributes earlier in the example.

11
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Running the Analysis

A

With the model loaded:

El Select the Solve Now button from the toolbar and click OK to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

Note. For this analysis the use of non-coincident joints (i.e. omitting the merge step)
and linear beam elements within a nonlinear analysis will cause warnings to be written
to the text output window. These warnings can be ignored. In addition, a warning
stating “RIGHTHAND SIDE WAS ZERO : NO SOLVING TOOK PLACE” written to
the same window can also be ignored. This latter warning relates to no attribute-based
loading being applied to the model, but the model has found equilibrium from the
pressure loading that was defined as part of defining the trilinear joint material, so
solving for this load is done.

If the analysis is successful...
Analysis loadcase results are added to the @ Treeview
In addition, these files will be created in the LUSASFiles32\<model name> folder:

U Embedded_wall~Analysis 1.out this output file contains details of model
data, assigned attributes and selected statistics of the analysis.
U Embedded_wall~Analysis 1.mys this is the LUSAS results file which is

loaded automatically into the @ Treeview to allow results processing to take
place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully. You may
download this file from the user area of the LUSAS website.

U embedded_wall _modelling.lvb carries out the modelling of the example.

12



Viewing the Results

|F“?\Jew... Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as Embedded Wall
e Use the default User-defined working folder.
e Ensure an Analysis category of 2D Inplane is set.

e C(Click the OK button.

Note. There is no need to enter any other new model details when a script is run to
build a model, since the contents of the script will overwrite any other settings made.

| File To recreate the model, select the file embedded_wall modelling.lvb that was

Script > downloaded and placed in a folder of your choosing.
Run Script...

;l Rerun the analysis to generate the results.

Viewing the Results

Analysis loadcase results are present in the (X Treeview.

A Deformed mesh layer will be automatically added to the Layers = Treeview:

13



Embedded Retaining Wall

e Turn on the Diagrams layer in L
the Layers Treeview. In the 1
Diagrams Properties dialog set
the Entity to Force/Moment —

Thick 2D Beam and the i \"_'
Component to Mz B
e In the panel at the bottom of the \

Layers Treeview  tick
Window Summary.

A maximum Bending Moment of /
342kNm can be seen to occur in the L]
retaining wall. ff

gk
e Double click the Diagrams item [

in the Layers =¥ Treeview. In the 16-6%
Diagrams Properties dialog set o
the Entity to Force/Moment —
Thick 2D Beam and the
Component to Fy

A maximum Shear Force of 78kN is My
seen to occur in the retaining wall.

e Now turn on the Values layer in the Layers Treeview.
In the Values Properties dialog set the Entity to
Displacement and the Component to DX

e On the Values Display tab check Show values of
Selection, check the Deform option, set a font Angle of
45 (degrees), click the OK button to return to the
Properties dialog and click the OK button again to return
to the model.

e Select the top-most node of the deformed mesh to display
the maximum deflection. A maximum deflection of
100mm is seen to occur.

|Fi||§ave— . El Save the model file.

e In the Layers Treeview turn-off the display of the
Diagrams, Values and Deformed mesh layers.

ISERETTEREETTEREL L
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| Attributes

Loading...

| Analyses

Loadicase...

Viewing the Results

Loadcase 2: Adding a propping force

For this example the previously calculated deflection of the wall has been considered to
be too large and the wall is to be propped at a depth of 2.5m from the top of the wall.
The propping force will be modelled using a concentrated load that will be increased
incrementally to calculate the propping force required to reduce the deflection to
30mm. The calculated propping force can then be used to design the anchoring system.

e Select the prop point on the wall at (0,-2.5). "
L» P s 21
e Drag and drop the loading dataset Prop Force from the 7
Treeview onto the model. R
e In the Loading Assignment dialog select Single loadcase, —=
select Loadcase 2 from the Loadcase list and ensure that SN D P
Set loadcase active is checked. S S
e Click the OK button to make the assignment. 1 S
—_— —
Note. Because new loading has been applied to the model a 1 ]
warning will be seen that stating that the previously obtained —_1 ]
results are out of date. = =
e In the Analyses @ Treeview, right click on Loadcase 2. 1 ]
From the Context menu select Controls > Nonlinear and —= —=
—_— —n
Transient = )
— —=
e In the Nonlinear & Transient dialog check the Nonlinear 1 ]
check box and select Automatic Incrementation. ]

With Load type set to Point loads and Point loads set to Concentrated click Next

Enter a value of 10 in the X direction, enter a dataset name of Prop Force and
click the Finish button to create the attribute

Click OK to create a second loadcase with the default name Loadcase 2

Set the Starting load factor to 1.0, set the Max change in load factor to 1.0 and
the Max total load factor to 10.0

Click the OK Button to make the changes and return to the model.

El Select the Solve Now button from the toolbar and click OK to run the
analysis.

Loadcase results for Loadcase 2 will be added to the @ Treeview. The last solved
nonlinear increment (Load factor = 10.0) will be set active by default.

15



Embedded Retaining Wall

Designing the wall

e In the Layers Treeview ensure the display of the Diagrams, Values and

Deformed mesh layers are turned on.

e Select the top node of the deformed wall as before. A value for
the first load increment will be shown (the value seen on the
adjacent image is for a different increment).

e With the values layer still set to display the horizontal
displacement (DX), set each of the load increments (load
factors) of Loadcase 2 active in turn to investigate the effect of
applying different prop forces to the top of the wall.

From examination it can be seen that a 30mm top of wall
displacement is achieved at Increment 6. This increment has a load
factor of 5.0 showing a required propping force of 5x10 = 50kN.

e Double click the Diagrams entry and in the Diagrams
Properties dialog ensure that entity Force/Moment — Thick 2D
Beam and component Mz are selected.

The moments in the wall can now be seen to be significantly
reduced, with the maximum being around 78kNm

i
|—» 965

&

[
e ]
L

l

111131},

L1l

11

Note. This example shows a prop force applied externally to the wall. If a soil
anchoring system were to be used to provide the restraint, a different modelling
approach would be necessary. In addition, the propping force required to reduce the
wall deflections may not be achievable in practice due to the soil type. In this case, the
design may require some iteration and re-running of the analysis to achieve acceptable

forces, moments and deflections.
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| Geometry
Point >
Move...
[ Tools
Mesh >
Mesh lock...
| File
Save As...

Viewing the Results

Looking to reduce the pile length

Once suitable deflections and design forces have been established
the required length of pile can be determined by reducing the
embedded length and ensuring the effect on the required deflection
is acceptable.

An initial estimate of the reduction can be sought by considering
where wall forces become negligible. To do this a diagram of Shear
force in the wall is to be plotted.

e In the Diagrams Properties dialog set the Entity to
Force/Moment — Thick 2D Beam and the Component to Fy

By inspection the shear within the wall for the bottom 5m length is
negligible and can be removed.

. ﬂ Select the bottom three points of the model and enter 5 in
Y translation. Click OK to reduce the wall depth.

Note. Again a “Results are out of date” warning will be seen. In addition, because
results are currently loaded whilst the geometry has been modified, the mesh will have
been locked and the updated joint mesh arrangement will not be immediately visible.
The mesh assignments will still be present for those lines and the model will solve, but
to see the updated mesh arrangement the mesh can be unlocked prior to a re-solve

taking place:

e This takes off the mesh lock, and on clicking Yes to the question
asked will display the updated mesh arrangement. If it is required
to see the joint element mesh, the Mesh layer would need to be
turned-on.

El Save the model file with a different name, such as
embedded_wall_reduced.mdl

° El Select the Solve Now button from the toolbar and click OK
to re-run the analysis.

L.
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Embedded Retaining Wall

e  With the top node of the wall selected, and the values
layer still set to display the horizontal displacement (DX),
and the diagrams layer set to show Force / Moment of
Mz, set each of the load increments (load factors) of
Loadcase 2 active in turn to investigate the effect of
applying different prop forces to the top of the wall.

From examination it can be seen that a 30mm top of wall
displacement is still achieved at Increment 6 (with a load
factor 5.0) so the reduction in length has not altered the top of
wall displacement by any appreciable amount.

Maximum bending moment in the wall is similar to that
previously achieved at 77kNm.

Further reduction in embedded length maybe possible by
repeating the previous steps and ensuring deflections remain
suitable.

This concludes the example.
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